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Installing and Configuring vCloud Connector
 Installing and Configuring vCloud Connector provides a brief overview of VMware vCloud ® Connector™ 2.0and vcloud.vmware.com. It also provides detailed information on installing and configuring vCloudConnector Server and vCloud Connector Nodes and setting up the vCloud Connector UI .
 Intended AudienceThis information is intended for anyone who wants to set up vCloud Connector (vCC). You should be familiarwith vSphere Client, the vCloud Director Web console, and deploying virtual appliances.
 VMware, Inc. 5
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vCloud Connector Editions 1vCloud Connector 2.0 has two editions: vCloud Connector 2.0 Core and vCloud Connector 2.0 Advanced.
 vCloud Connector 2.0 Advanced requires a valid vCloud Suite 5.1 license key to enable its features. In additionto vCloud Connector 2.0 Core features, it includes the following advanced features:n Content Sync
 n Stretch Deploy (also referred to as Datacenter Extension)
 See Chapter 5, “Entering the License Key for vCloud Connector Advanced Edition,” on page 49 forinformation on how to assign the license key.
 VMware, Inc. 7
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vCloud Connector Overview 2This section provides an overview of vCloud Connector and the vcloud.vmware.com website.
 It includes information on the functionality of vCloud Connector and the components that make it up. It alsodescribes vcloud.vmware.com, a website that extends the functionality of vCloud Connector to the browser.
 n vCloud Connector on page 9vCloud Connector is an enterprise product that provides a single user interface for overseeing multiplepublic and private clouds and for transferring cloud content from one cloud to another. It allows you toconnect multiple clouds, both internal and external, in a single user interface.
 n The vcloud.vmware.com Website on page 10The website vcloud.vmware.com allows you to access the vCloud Connector UI through your browser.
 vCloud ConnectorvCloud Connector is an enterprise product that provides a single user interface for overseeing multiple publicand private clouds and for transferring cloud content from one cloud to another. It allows you to connectmultiple clouds, both internal and external, in a single user interface.
 Using vCloud Connector, you can stop and start virtual machines, check their performance, and transfer virtualmachines, vApps, and templates from one cloud to another.
 Using vCloud Connector Advanced edition, you can also extend your private datacenter to a public vCloudand set up a Content Library to distribute and synchronize templates across clouds.
 vCloud Connector ComponentsvCloud Connector consists of three distinct components: the vCloud Connector UI, the vCloud ConnectorServer, and vCloud Connector Nodes.
 VMware, Inc. 9
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Figure 2-1. vCloud Connector Components
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 vCloudConnector UI
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 The vCC UI can be surfaced in vSphere Client orthrough the vcloud.vmware.com website.
 A single vCC Servercontrols everything.
 A vCC node ineach cloud
 manages datatransfer.
 Only browsers behind thefirewall have access.
 vSphere
 vCloud Connector UIvCloud Connector UI is the user interface that vCloud Connector Server produces. It can be surfaced in vSphereClient or at vcloud.vmware.com. If you decide to display your UI via vcloud.vmware.com, and your vCloudConnector Server is behind a firewall, only browsers also behind the firewall can see the UI. You decide whereto display the UI during the configuration process.
 vCloud Connector ServervCloud Connector Server is a virtual appliance that coordinates the activity of vCloud Connector, controlsvCloud Connector Nodes, and produces the vCloud Connector UI. Only one vCloud Connector Server isneeded.
 vCloud Connector NodesvCloud Connector Nodes are virtual appliances that handle transferring content from one cloud to another.Transfers between clouds that are interrupted, for example because of network problems, can be resumed atthe point that they were interrupted. A vCloud Connector Node must be installed in every vSphere or vCloudcloud that vCloud Connector oversees.
 The vcloud.vmware.com WebsiteThe website vcloud.vmware.com allows you to access the vCloud Connector UI through your browser.
 The website is designed to help you make the move to a hybrid cloud environment. You can view your vCloudConnector instance through it and you can share access to your clouds with others. The website also connectsyou to a range of public cloud service providers offering evaluation cloud offers and a community of othervCloud Connector users.
 Installing and Configuring vCloud Connector
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Planning Your vCloud ConnectorInstallation 3
 Before you install vCloud Connector, you need to do some basic high-level planning.
 You need to decide:
 n Where you want to install the vCloud Connector Server
 n Which clouds you want to be able to add to the vCloud Connector UI. You must install a vCloud ConnectorNode in each cloud that you want to add.
 On vCloud Director clouds, you do not need to install a Node for each organization. vCloud ConnectorNodes are multi-tenant, that is, one Node can be used by multiple organizations to transfer content to andfrom the cloud. If you are a public vCloud service provider or the system administrator of a private vCloudDirector cloud that has many organizations, you can choose to install one Node in the cloud for multipleorganizations to use.
 n Where you want to access the vCloud Connector UI: in the vSphere Client, on vcloud.vmware.com, orboth.
 You also need to collect specific information to use during the installation and configuration process. Whatyou need to know depends on your specific installation decisions. A detailed description of the informationyou should collect is covered in “Collect Necessary Information,” on page 14.
 Deploying vCloud Connector as a vCloud Service ProvidervCloud Connector Nodes are multi-tenant, that is, one Node can be used by multiple organizations to transfercontent to and from the cloud. As a vCloud Service Provider, you can deploy one vCloud Connector Node onthe cloud which can be used by multiple customers (organizations).
 Deployment scenarios include:
 n Deploy one vCloud Connector Node on the cloud for multiple organizations to use.
 You install and configure the Node and provide the Node URL to customers. Customers register the Nodewith their own vCloud Connector Servers.
 n Partition your installation for different sets of customers and deploy multiple vCloud Connector Nodes,one for each set of customers.
 You install and configure the Nodes and send the appropriate Node URL to each set of customers.Customers register the Node with their own vCloud Connector Servers.
 To use a multi-tenant Node deployed by a vCloud Service Provider, customers (organization administrators)register the Node with their own vCloud Connector Server using the Node URL provided by the vCloudService Provider and their own organization credentials. Organization administrators have access to theirorganization's logs from their vCloud Connector Server Admin Web console.
 VMware, Inc. 11
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Installing vCloud Connector 4Installing vCloud Connector is a multi-step process. This section gives you a high-level overview of the stepsyou need to take.
 Figure 4-1. vCloud Connector Installation and Configuration Workflow
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 data
 vSphere
 vSphereClient
 vCloudConnector UI
 browser
 vCloudConnector UI
 vcloud.vmware.com10
 6
 4 5
 7 6 7
 internal
 browser
 external
 vcloud.vmware.com
 vCloudConnection
 Server
 privatevCloud
 node
 node
 nodepubliccloud
 publiccloudnode
 vcloud.vmware.com
 server
 8 8
 1. GUID-5FC26CA8-CB0F-4211-AAC0-5DC594858CA7 Add a line from vCloud Connector Server to the cloud labeled "public cloud". This is the one that already has a line to the node but not to the cloud. 2. GUID-C3B04619-5EB8-4107-82C2-471E5EA237CD: Add a line from vCloud Connector Server to the cloud labeled "public cloud". (There are two clouds with the label -- one has a line already.)
 This figure illustrates all the combinations that you can use with vCloud Connector. Typically, you would usea subset of these.
 Common installation scenarios include using vCloud Connector to
 n Connect a private vSphere cloud with a public vCloud.
 n Connect a private vCloud Director cloud with a public vCloud.
 n Connect a private vSphere cloud with a private vSphere cloud.
 n Connect a private vCloud Director cloud with a private vCloud Director cloud.
 You install a vCloud Connector Node in each cloud that you want to connect. You only need one vCloudConnector Server.
 VMware, Inc. 13
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Procedure
 1 Collect Necessary Information on page 14Print this worksheet section to help you collect the information you need to install and configure vCloudConnector.
 2 Check System Requirements on page 16You must ensure that your system meets the minimum requirements before you install vCloudConnector.
 3 Download the vCloud Connector Virtual Appliances on page 18vCloud Connector Server and vCloud Connector Nodes are packaged as virtual appliances. Youdownload the virtual appliances from the vcloud.vmware.com website or the vCloud ConnectorDownload page.
 4 Install vCloud Connector Server on page 18You can install vCloud Connector Server in a vSphere cloud or in a vCloud Director cloud.
 5 Configure vCloud Connector Server on page 25You use the vCloud Connector Server Admin Web console to do basic configuration tasks, such asdefining your time zone, specifying proxy servers, or setting log levels. What you need to do dependson your particular installation.
 6 Install vCloud Connector Nodes on page 28You can install vCloud Connector Nodes in vSphere or vCloud Director clouds.
 7 Register vCloud Connector Nodes with Clouds on page 36After you install a vCloud Connector Node, you need to register it with the cloud on which it is installed.
 8 Configure vCloud Connector Nodes on page 37You use the vCloud Connector Node Admin Web console for each of your Nodes to do basicconfiguration tasks, such as defining your time zone, specifying proxy servers, or setting log levels. Whatyou need to do depends on your particular installation.
 9 Register vCloud Connector Nodes with vCloud Connector Server on page 40You use the vCloud Connector Server Admin Web console to register vCloud Connector Nodes with thevCloud Connector Server. The Nodes are installed on vSphere, private vCloud Director clouds, or publicvClouds. The registration allows the Server to manage the Nodes.
 10 Register the vCloud Connector UI on page 41You can register the vCloud Connector UI to appear in your vSphere Client, vcloud.vmware.com, orboth.
 11 Prepare vCloud Connector for Production Use on page 43Before you place vCloud Connector into production use, you must prepare it for a full productionenvironment.
 Collect Necessary InformationPrint this worksheet section to help you collect the information you need to install and configure vCloudConnector.
 AccountsYou need the following accounts:
 Installing and Configuring vCloud Connector
 14 VMware, Inc.
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Table 4-1. Account Information
 Account Type Information Needed Used For
 A vmware.com store account.Store accounts are free fromvmware.com.
 Username and password Accessingvcloud.vmware.com
 One of the following:n vCenter Server
 administrator accountn vCloud Director account
 with at least OrgAdministrator status
 Username, password andURL or IP address for theappropriate entity
 Installing vCloudConnector Server
 vCenter Server administratoraccount for each vSpherecloud
 Username, password andURL or IP address
 Installing vCloudConnector Node
 vCloud Director accountwith at least OrgAdministrator status for eachvCloud Director cloud
 Username, password andURL or IP address
 Installing vCloudConnector Node
 Proxy ServersYou need the following proxy information:
 Table 4-2. Proxy Information
 Install Type Information Needed Condition
 vCloud Connector Server host:port If the Server needs a proxyto be able to access systemsbeyond the firewall in thelocation in which it isinstalled.
 vCloud Connector Node - perNode
 host:port If the Node needs a proxy tobe able to access systemsbeyond the firewall in thelocation in which it isinstalled.
 NetworkIf you are using a static IP (not using DHCP) for vCloud Connector Server or vCloud Connector Node, youneed the following information for each instance.
 Table 4-3. Network Information
 Network Information
 An available static IP address
 The netmask for that address
 The IP address of the gateway
 The IP address of a primary and secondary DNS server
 A hostname (optional)
 For more information on network paths in data transfers, see Chapter 7, “Cross-Cloud Data Transfer andNetwork Connectivity,” on page 55.
 Chapter 4 Installing vCloud Connector
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Displaying the vCloud Connector UIIf you want to set up the vCloud Connector UI to display in a vSphere Client, you need to know:
 Table 4-4. vCloud Connector UI in vSphere
 vCloud Connector UI in vSphere
 The IP address or fully qualified domain name of the vCenterServer to which you will be connecting.
 A username and password for the vCenter Server.
 The IP address or fully qualified domain name of thedeployed vCloud Connector Server. This information isassigned when the vCloud Connector Server is firstdeployed.
 If you want to display the vCloud Connector UI at vcloud.vmware.com, you need to know:
 Table 4-5. vCloud Connector UI in vcloud.vmware.com
 vCloud Connector UI in vcloud.vmware.com
 The vmware.com account username and password withwhich you want to access vCloud Connector UI viavcloud.vmware.com.
 The IP address or fully qualified domain name of the vCloudConnector Server. This information is assigned when theServer is first deployed.
 Check System RequirementsYou must ensure that your system meets the minimum requirements before you install vCloud Connector.
 Hardware and Software RequirementsTo deploy and configure vCloud Connector Server and Nodes, you need the following:
 Installing and Configuring vCloud Connector
 16 VMware, Inc.
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Table 4-6. VMware Products
 Product Supported Version Notes
 vSphere 4.0, 4.1, 5.0, 5.1 If you are deploying the vCC Server orvCC Nodes on vSphereNOTE To use the Stretch Deploy feature(Datacenter Extension), you must installvSphere 5.1.
 vCloud Director 1.5, 5.1 If you are deploying the vCC Server orvCC Nodes on vCloud DirectorNOTE To use the Stretch Deploy feature(Datacenter Extension), you must installvCloud Director 5.1.
 vShield Manager 5.1.2 Required for the Stretch Deploy feature(Datacenter Extension) only.
 NOTE The Stretch Deploy feature has special system requirements. See System Requirements for StretchDeploy in Using vCloud Connectorfor more information.
 NOTE If you are deploying on vSphere, you also need a Microsoft Windows desktop with vSphere Clientinstalled.
 To use the vCloud Connector UI through your browser, and to access the vCloud Connector Server and NodeWeb Admin consoles, you need a browser.
 Table 4-7. Supported Browsers
 Browser Supported Version
 Internet Explorer 8, 9
 Firefox 15, 16
 Chrome 22, 23
 The browser must be set to accept third-party cookies.
 Required PortsvCloud Connector uses the following ports to communicate between its various components: Server, Nodes,vcloud.vmware.com, and the Server and Node Admin Web consoles.
 Table 4-8. Port Information
 Port Number Use
 443 Used when SSL is enabled.This port is used for communication between the vCC Server and vCC Nodes andbetween Nodes.
 80 Used when SSL is disabled.This port is used for communication between the vCC Server and vCC Nodes andbetween Nodes.
 5480 This port is used for communication with the vCC Server and vCC Node Admin WebConsoles.
 NOTE Ports 8080 and 8443 are used for the Local Content Directory Node, which is a node that is automaticallyinstalled with the vCloud Connector Server and which is used for the Content Library. Port 8080 is used whenSSL is disabled and port 8443 is used when SSL is enabled.
 Chapter 4 Installing vCloud Connector
 VMware, Inc. 17
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Download the vCloud Connector Virtual AppliancesvCloud Connector Server and vCloud Connector Nodes are packaged as virtual appliances. You downloadthe virtual appliances from the vcloud.vmware.com website or the vCloud Connector Download page.
 Prerequisites
 You have collected the information specified in “Collect Necessary Information,” on page 14.
 Procedure
 1 Go to vcloud.vmware.com.
 2 Log on using your vmware.com store account.
 If you do not have a vmware.com store account, register at www.vmware.com. The account is free.
 3 Click vCloud Connector in the left navigation bar.
 4 Click Download.
 5 Read and accept the EULA.
 6 Click zip for the vCloud Connector Server virtual appliance and download it to your desktop.
 7 Click zip for the vCloud Connector Node virtual appliance and download it to your desktop.
 8 In separate directories, unzip the vCloud Connector Server and the vCloud Connector Node virtualappliance zip files.
 Install vCloud Connector ServerYou can install vCloud Connector Server in a vSphere cloud or in a vCloud Director cloud.
 Only one vCloud Connector Server is required for each vCloud Connector installation. Choose one of thefollowing options to install your Server.
 Install vCloud Connector Server in vSphereYou can install vCloud Connector Server in vSphere 4.0, 4.1, 5.0, or 5.1.
 Prerequisites
 You must have an administrator account on the vSphere in which you deploy the vCloud Connector Server.You must have the unzipped version of the template you downloaded in “Download the vCloud ConnectorVirtual Appliances,” on page 18.
 Procedure
 1 Log on to vSphere Client.
 2 Select File > Deploy OVF template.
 3 Click Browse to navigate to the OVF directory of the Server zip file.
 4 Click Next.
 5 Proceed through the wizard.
 You can either use the Networking Properties step in the wizard to set basic network properties or youcan wait and set those properties when you configure your server.
 NOTE If you are going to use a static IP address, you need to assign it here. Proxy information is set during“Configure vCloud Connector Server,” on page 25
 Installing and Configuring vCloud Connector
 18 VMware, Inc.
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6 In the vSphere Client, select Inventory > VMs and Templates to see the created virtual machine in thetree.
 7 Right-click the virtual machine and select Power > Power on to power on the machine.
 8 Click the Summary tab and find the vCloud Connector Server's IP address in the General section. The IPaddress field (not the Host field) displays the IP address of the vCloud Connector Server. Make a note ofthe IP address. You will need it later in the process.
 Install vCloud Connector Server in vCloud Director 1.5You can install vCloud Connector Server in vCloud Director 1.5.
 NOTE If you install vCloud Connector Server in a public cloud, you can only connect to public clouds in yourvCloud Connector UI.
 Prerequisites
 You must have at least Organization Administrator access in the vCloud Director on which you install thevCloud Connector Server.
 Procedure
 1 Add vCloud Connector Server to a vCloud Director 1.5 Catalog as a vApp Template on page 19Before you can deploy a vCloud Connector Server in a vCloud Director 1.5 cloud, you must upload thevirtual appliance to a catalog as a vApp template. You do not need to upload an additional template ifa template is already uploaded to a master catalog that multiple organizations share.
 2 Create the vCloud Connector Server from the Template in a vCloud Director 1.5 Cloud on page 20After the vCloud Connector Server is added to the vCloud Director 1.5 cloud as a template, you can useit to create a running instance on that cloud.
 3 Set Up NAT Mapping for vCloud Connector Server in vCloud Director 1.5 on page 21If you select a NAT-based network connection when you deploy your vCloud Connector Server, youneed to set up NAT mapping and firewall rules.
 Add vCloud Connector Server to a vCloud Director 1.5 Catalog as a vApp TemplateBefore you can deploy a vCloud Connector Server in a vCloud Director 1.5 cloud, you must upload the virtualappliance to a catalog as a vApp template. You do not need to upload an additional template if a template isalready uploaded to a master catalog that multiple organizations share.
 Prerequisites
 You must have System Administrator or Organization Administrator access on the vCloud Director cloud onwhich you install the vCloud Connector Server. You must have the unzipped version of the template youdownloaded in “Download the vCloud Connector Virtual Appliances,” on page 18.
 Procedure
 1 Log on to the vCloud Director Web console using a supported browser.
 2 Click Catalogs.
 If you log on as System Administrator, select your organization first, then click the Catalogs tab.
 3 Double-click the catalog to which you want to upload the vCloud Connector Server, then click the vAppTemplates tab.
 4 Click the Upload icon.
 Chapter 4 Installing vCloud Connector
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5 In the Upload OVF package as a vApp Template dialog box, click Browse, accept the security certificateif you are prompted to do so, and select the vCloud Connector Server OVF file that you downloaded.
 6 Specify a name and, optionally, a description, for the vApp template.
 7 Select the virtual datacenter and catalog for the template.
 8 Click Upload.
 The upload process begins. You can monitor the status of the upload in the Transfer Progress popup.
 NOTE It may take several seconds after the upload itself has finished for the process to finalize in the cloud.
 Create the vCloud Connector Server from the Template in a vCloud Director 1.5CloudAfter the vCloud Connector Server is added to the vCloud Director 1.5 cloud as a template, you can use it tocreate a running instance on that cloud.
 Prerequisites
 You must have at least Organization Administrator access on the vCloud Director cloud on which you installthe vCloud Connector Server.
 Procedure
 1 On the vApp Templates tab of the catalog to which you uploaded, right-click the name of your vCloudConnector Server template and select Add to My Cloud.
 The Add to My Cloud popup appears.
 2 Give the Server vApp an easily identifiable name and provide a description.
 3 Set the leases for the Server vApp and click Next.
 4 Read and accept the EULA, and click Next.
 5 Select an appropriate network from the Network drop-down menu.
 Unless all your vCloud Connector Nodes and the vCloud Connector Server are behind the same firewalland you do not plan to use vcloud.vmware.com to access the vCloud Connector UI, you must select anetwork that is configured to access the Internet. Ask your service provider or network administrator formore information.
 NOTE If your provider uses NAT, you will need to set up NAT mapping after your Server is deployed.See “Set Up NAT Mapping for vCloud Connector Server in vCloud Director 1.5,” on page 21.
 6 Select the appropriate IP Assignment from the drop-down menu and click Next.
 If there is a static IP pool, that is probably a reasonable choice. Ask your Service Provider or NetworkAdministrator for more information.
 7 In the Networking Properties page, use the information you collected before you began installing vCloudConnector to specify the DNS server, IP address, Netmask, and Default Gateway. If you are using DHCP,leave the fields blank.
 8 In the Configure Networking page, leave both check boxes unselected, and click Next.
 9 In the Ready to Complete page, review the settings and click Finish.
 10 Click the My Cloud tab, then select vApps in the My Cloud panel.
 You see the vApp being created.
 11 In the My Cloud panel, select VMs, right-click your vCloud Connector Server, and select Properties.
 Installing and Configuring vCloud Connector
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12 In the Virtual Machine Properties window, click the Guest OS Customization tab.
 13 Select Enable guest customization, then click OK.
 14 In the My Cloud panel, select vApps, then right-click the console icon of the vCloud Connector Serverand select Start.
 15 When the Server on vCloud Director 1.5 is in running state, click VMs in the My Clouds panel and makea note of the IP address of the Server VM.
 You need the IP address later in the registration process.
 Set Up NAT Mapping for vCloud Connector Server in vCloud Director 1.5If you select a NAT-based network connection when you deploy your vCloud Connector Server, you need toset up NAT mapping and firewall rules.
 There are multiple approaches to managing this issue. Decide whether you wish to use NAT to forward onlythe ports necessary for vCloud Connector operation or to forward all ports and then set up a firewall rule tofilter all but the following required ports:
 n Port 443: For communication between vCloud Connector Server and Nodes and between Nodes. This portis used when SSL is enabled; when SSL is disabled, port 80 is used.
 n Port 5480: For communication with the vCloud Connector Server Admin Web admin console, for exampleduring the registration process.
 Prerequisites
 Your appliance is deployed and you are logged on to the vCloud Director Web console as OrganizationAdministrator or System Administrator.
 Procedure
 1 Click the Administration tab, then select Networks in the left panel.
 2 Find the network you are using in the Networks list, right-click, and select Configure Services.
 3 In the Configure Services dialog box, click the NAT Mapping tab and click Add at the bottom of the popupto create the NAT rule.
 The Add NAT Rule popup appears.
 4 Select one of the External IP addresses from the drop-down list.
 Note this address if you plan to set up a firewall rule.
 5 If you wish to NAT all ports, enter * for the first port entry.
 If you wish to NAT only the required ports, create a rule for each port.
 6 Enter the internal IP address from your initial setup and match the port entry for this rule.
 7 Click OK and click OK again.
 8 If you are using a firewall rule to control traffic, click the Firewall tab and select the Enable firewall checkbox.
 9 Click Add at the bottom of the pop-up to create a new firewall rule.
 Create a rule for each necessary port.
 The Add Firewall Rule popup appears.
 10 Give the rule a name and select the Incoming option.
 Chapter 4 Installing vCloud Connector
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11 Type the source IP address and the source port.
 For incoming traffic, the source is the external network. This is the address you selected in Step 4 above.
 12 Type the destination IP address and port.
 The destination IP address is the internal IP address from your initial setup.
 13 Select the Allow action.
 14 Select the Enabled check box.
 15 Click OK and OK to create the rule.
 Install vCloud Connector Server in vCloud Director 5.1You can install vCloud Connector Server in vCloud Director 5.1.
 You must have at least Organization Administrator access in the vCloud Director cloud on which you installthe vCloud Connector Server.
 NOTE If you install vCloud Connector Server in a public cloud, you can only connect to public clouds in yourvCloud Connector UI.
 1 Add the vCloud Connector Server to a vCloud Director 5.1 Catalog as a vApp Template on page 22Before you can deploy a vCloud Connector Server in a vCloud Director 5.1 cloud, you must upload thevirtual appliance to a catalog as a vApp template. You do not need to upload an additional template ifa template is already uploaded to a master catalog that multiple organizations share.
 2 Create the vCloud Connector Server from the Template in a vCloud Director 5.1 Cloud on page 23After the vCloud Connector Server is added to the vCloud Director 5.1 cloud as a template, you can useit to create a running instance on that cloud.
 3 Set Up NAT Mapping for vCloud Connector Server in vCloud Director 5.1 on page 24If you select a NAT-based network connection when you deploy your vCloud Connector Server, youneed to set up NAT mapping and firewall rules.
 Add the vCloud Connector Server to a vCloud Director 5.1 Catalog as a vAppTemplateBefore you can deploy a vCloud Connector Server in a vCloud Director 5.1 cloud, you must upload the virtualappliance to a catalog as a vApp template. You do not need to upload an additional template if a template isalready uploaded to a master catalog that multiple organizations share.
 Prerequisites
 You must have Organization Administrator or System Administrator access on the vCloud Director cloud onwhich you install the vCloud Connector Server. You must have the unzipped version of the template youdownloaded in “Download the vCloud Connector Virtual Appliances,” on page 18.
 Procedure
 1 Log on to the vCloud Director Web console using a supported browser.
 2 Click Catalogs.
 If you log on as System Administrator, select your organization first, then click the Catalogs tab.
 3 Select the catalog to which you want to upload the vCloud Connector Server, then click the vAppTemplates tab.
 4 Click the Upload icon.
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5 In the Upload OVF package as a vApp Template popup, click Browse and select the vCloud ConnectorServer OVF file that you downloaded.
 6 Specify a name and, optionally, a description, for the vApp template.
 7 Select the virtual datacenter, catalog, and storage profile for the template.
 8 Click Upload.
 The upload process begins. You can monitor the status of the upload in the Transfer Progress popup.
 NOTE It may take several seconds after the upload itself has finished for the process to finalize in the cloud.
 Create the vCloud Connector Server from the Template in a vCloud Director 5.1CloudAfter the vCloud Connector Server is added to the vCloud Director 5.1 cloud as a template, you can use it tocreate a running instance on that cloud.
 Prerequisites
 You have System Administrator or Organization Administrator access on the vCloud Director cloud on whichyou install the vCloud Connector Server.
 Procedure
 1 In the vApp Templates tab of the catalog to which you uploaded the vCloud Connector Server, right-clickthe name of the Server template and select Add to My Cloud.
 2 Read and accept the EULA and click Next.
 3 Give the Server vApp an easily identifiable name, provide a description, and click Next.
 Default lease information is displayed; you can modify the leases later through the vApp propertiessettings.
 4 In the Configure Resources page
 a Select the virtual datacenter in which to store the Server vApp.
 b Provide a name for the virtual machine. This name is displayed in the vCloud Connector UI to identifyyour Server.
 c Select a Storage Profile.
 d Click Next.
 5 Select an appropriate network from the Destination drop-down menu.
 Unless all the Nodes controlled by your Server are behind the same firewall, you need to select a networkthat is configured to access the Internet. Ask your Service Provider or Network Administrator for moreinformation.
 6 Select the appropriate IP Assignment from the drop-down menu and click Next.
 If there is a static IP pool, that is probably a reasonable choice. Ask your Service Provider or NetworkAdministrator for more information. If your provider uses NAT, you will need to set up NAT mappingafter your Server is deployed. See “Set Up NAT Mapping for vCloud Connector Server in vCloud Director5.1,” on page 24.
 7 In the Networking Properties page, use the information you collected before you began installing vCloudConnector to specify the DNS server, IP address, Netmask, and Default Gateway. If you are using DHCP,leave the fields blank.
 8 In the Ready to Complete page, review your settings and click Finish.
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9 Click the My Cloud tab, then select vApps in the My Cloud panel.
 You can see the vApp being created in the vApps section.
 10 Select VMs in the My Cloud panel, right-click your vCloud Connector Server, and select Properties.
 11 In the Virtual Machine Properties page, click the Guest OS Customization tab.
 12 Check Enable guest customization.
 13 Click OK.
 14 In the My Cloud panel, select vApps, then right-click the console icon of your vCloud Connector Serverand select Start.
 15 When the vCloud Connector Server is in running state, click VMs in the My Cloud panel and make a noteof the IP address of your Server.
 You need the IP address later in the registration process.
 Set Up NAT Mapping for vCloud Connector Server in vCloud Director 5.1If you select a NAT-based network connection when you deploy your vCloud Connector Server, you need toset up NAT mapping and firewall rules.
 There are multiple approaches to managing this issue. Decide whether you wish to use NAT to forward onlythe ports necessary for vCloud Connector operation or to forward all ports and then set up a firewall rule tofilter all but the following required ports:
 n Port 443: For communication between vCloud Connector Server and Node and between Nodes. This portis used when SSL is enabled; when SSL is disabled, port 80 is used.
 n Port 5480: For communication with the vCloud Connector Server Admin Web console, for example duringthe registration process.
 Prerequisites
 Your appliance is deployed and you are logged on to the vCloud Director Web console.
 Procedure
 1 Click the Administration tab and select Virtual Datacenters in the left panel.
 2 Double-click your virtual datacenter.
 3 Click the Org vDC Networks tab.
 4 Find the network you are using in the list of networks, right-click, and select Configure Services.
 5 Click the NAT tab.
 6 Click Add DNAT to add the rule.
 The Add Destination NAT Rule pop-up appears.
 7 Specify the external IP address.
 8 If you wish to NAT all ports, enter * for the first port entry.
 If you wish to NAT only the required ports, create a rule for each port.
 9 Enter the internal IP address from your initial setup and match the port entry for this rule.
 10 Click OK and click OK again.
 11 If you are using a firewall rule to control traffic, click the Firewall tab and select the Enable firewall checkbox.
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12 Click Add at the bottom of the page to create a new firewall rule.
 Create a rule for each required port.
 The Add Firewall Rule popup appears.
 13 Select the Enabled check-box.
 14 Give the rule a name.
 15 Type the source IP address and the source port.
 For incoming traffic, the source is the external network. This is the address you selected in Step 7 above.
 16 Type the destination IP address and port.
 The destination IP address is the internal IP address from your initial setup.
 17 Select the protocol.
 18 Select Allow.
 19 Click OK and OK to create the rule.
 Configure vCloud Connector ServerYou use the vCloud Connector Server Admin Web console to do basic configuration tasks, such as definingyour time zone, specifying proxy servers, or setting log levels. What you need to do depends on your particularinstallation.
 The vCloud Connector Server Admin Web console interface is divided into five tabs, with the first three tabs,System, Network, and Update, and part of the fourth, Server, being used for general configuration.
 Prerequisites
 The vCloud Connector Server instance is running and you have the IP address for it that you wrote downwhen you installed it. You also have the information you gathered in “Collect Necessary Information,” onpage 14.
 Procedure
 1 Go to the vCloud Connector Server Admin Web console at https://<vCC Server IP address>:5480.
 2 If you receive a certificate warning, accept the certificate.
 3 Log on to the Server Admin Web console as admin.
 The default password is vmware. Check the Web console title to confirm that you are configuring the vCloudConnector Server.
 4 Use the information you collected in “Collect Necessary Information,” on page 14 to complete generalconfiguration.
 5 When you have finished with general configuration, keep the Server Admin Web console page open tothe Server tab in your browser.
 System Tab - ServerThe System tab provides general information on the vCloud Connector Server virtual appliance, allows youto configure time zones, and lets you shut down and reboot the appliance.
 InformationThe Information tab provides general information on the virtual appliance, such as the version number andthe host name. You can also reboot and shut down the Server from here.
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Time ZoneThe Time Zone tab allows you to set your local time zone. Click System Time Zone to see a drop-down listdisplaying time zones of the world. Select a time zone and click Save Settings.
 NOTE Changes in time zone settings are not reflected in logs, etc. until the service is reset. Click Reboot in theInformation tab to restart the Server.
 The virtual hardware clock is always maintained in UTC, which the virtual appliance converts to local time.Correct local time is important for the update repository and VMware Update Manager.
 Network Tab - ServerOn the Network tab, you can view network related information about the appliance, switch between DHCPand static IP addresses, and set up proxy information.
 StatusThe Network Status tab provides already configured network information about your appliance, such as DNSservers, network interfaces, and IP addresses. Click Refresh to update your information.
 AddressThe Network Address Settings tab allows you to specify static IP information for your appliance or to retrieveIP settings from a DHCP server.
 NOTE If you set a static IP address you must make sure that there are values for all of the displayed fields. InvCloud Director installations, you must set Preferred and Alternate DNS servers manually. Talk to your ServiceProvider or Network Admin for the appropriate addresses. You recorded the information that you need forthese settings in “Collect Necessary Information,” on page 14.
 For more information about network paths in data transfers, see Chapter 7, “Cross-Cloud Data Transfer andNetwork Connectivity,” on page 55.
 Click Save Settings to accept any changes that you made to the network address settings. Click CancelChanges to discard the changes.
 NOTE If you are using static IP settings, and you update the hostname and IP settings at the same time, onlythe IP settings are saved. The hostname is not saved. Update the Hostname field separately.
 Also note that if you change the IP address, you will not see your changes until you log out and log back in tothe Admin Web console using the new IP address.
 ProxyThe Proxy Settings tab allows you to set up any necessary proxy settings, including address and port. Set thisif the appliance must use a proxy to reach systems beyond the firewall at the installation location.
 You recorded the information that you need for these settings in “Collect Necessary Information,” onpage 14.
 Click Save Settings to accept any changes that you made to the proxy settings. Click Cancel Changes to discardthe changes.
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Update Tab - ServerThe Update tab allows you to check the update status of your virtual appliance and to set your update policy.
 StatusThe Status section allows you to view information about your virtual appliance or to check for and installupdates. Click Check Updates to check for updates from the update repository, shown in the AvailableUpdates pane. Click Install Updates to install the updates.
 SettingsThe Update Settings section allows you to determine when you want to check for updates. You should leavethe Use Default Repository button selected. Save any changes you make by clicking Save Settings.
 Server TabThe Server tab has two parts. One part allows you to change the Server administrator password, adjust loglevels, and manage SSL certificates. The other part is used later, in the registration processes.
 GeneralThe General Settings section allows you to change the administrator password for the vCloud ConnectorServer, provide a license key to enable advanced features in the vCloud Connector Advanced edition, set logfile severity levels, and download log files. Change admin userpassword
 Specify a new administrator password for the vCloud Connector Server, then click Confirm newpassword. You should change the default password.
 vCC License To enable advanced features that are available in vCloud Connector 2.0 Advanced edition, entera valid vCloud Suite 5.1 license key, then click Update Key.
 Log levels Set the severity level for vCloud Connector Server log files, then click Change log level.
 Download logs Click to download a zip file of vCloud Connector Server log files.
 SSLThe Manage SSL Certificates section allows you to disable or enable SSL and to manage your certificates.vCloud Connector Server has SSL disabled by default and includes a self-signed certificate. Before going intoproduction, replace the certificate with a valid certificate. DisableSSL/Enable SSL
 Select Enable SSL if you want to enable HTTPS communication. When you enable SSL, the port thatvCloud Connector Server uses changes from 80 to 443.If you enable SSL for the Server, replace its self-signed certificate with a valid certificate.NOTE If you enable SSL but do not update the certificate to a valid certificate, you will get an Unableto reach server error when you attempt to use vCloud Connector from the vcloud.vmware.comsite. See Cannot Access vCC Server from vcloud.vmware.com in Using vCloud Connectorfor moreinformation.NOTE After you enable or disable SSL, you must update the Server's registration withvcloud.vmware.com. You do this from the Server > vcloud.vmware.com tab.
 Key Info Displays information about the default key provided.
 Certificate Info Displays information about the self-signed certificate that is provided with the vCloud ConnectorServer.
 Generate New Key If you need to generate a new private key in order to obtain a valid certificate from your CertificateAuthority, type the required information and click Generate Key.NOTE Fields in this section do not support multi-byte characters. Use only ASCII characters for thevalues you enter. If you enter non-ASCII characters, a garbled value is displayed.
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Generate anddownload CSR
 Click to create a Certificate Signing Request and save it to your computer. Use the saved hcserver.csrfile to get a certificate from your Certificate Authority.
 Upload a new X.509 SSL Certificate
 Once you have your certificate, use the Browse button to locate it, then click Upload.
 For more information on installing a valid certificate, see “Add Valid SSL Certificates,” on page 43.
 vSphere Client and vcloud.vmware.com TabsThese tabs are used to register the vCloud Connector UI. For more information, see “Register the vCloudConnector UI,” on page 41.
 Nodes TabThe Nodes tab in the Server Admin Web Console lets you register vCloud Connector Nodes with your vCloudConnector Server, download Node log files, and register Stretch Deploy settings
 Manage NodesIn the Manage Nodes section, you can view the vCloud Connector Nodes that are currently registered withthe vCloud Connector Server and perform tasks related to Nodes.
 Table 4-9. Options
 Task
 To register a Node with the Server Click Register Node. See “Register vCloud Connector Nodeswith vCloud Connector Server,” on page 40.
 To edit a Node's registration Click the gears icon next to the Node and select Edit.
 To unregister a Node from the Server Click the gears icon next to the Node and select Unregister.
 To download Node log files Click the gears icon next to the Node and select DownloadLogs.
 To specify Stretch Deploy settings Click the gears icon next to the Node and select StretchDeploy Settings. See Using Stretch Deploy in Using vCloudConnector.
 To unregister Stretch Deploy settings Click the gears icon next to the Node and select UnregisterStretch Deploy Settings. See Using Stretch Deploy in UsingvCloud Connector.
 Install vCloud Connector NodesYou can install vCloud Connector Nodes in vSphere or vCloud Director clouds.
 You must install a vCloud Connector Node in every cloud you want to connect and oversee using vCloudConnector.
 vCloud Connector does not require every organization in a vCloud Director cloud to install its own vCloudConnector Node in the cloud. If you are a public vCloud service provider hosting many organizations, youcan choose to install one Node in the cloud and make it available to multiple organizations. Similarly, if youhave a private vCloud Director cloud with many organizations, you can install one Node that will be used bymultiple organizations.
 If you are a user of a service provider's public vCloud or of a private vCloud that already has a vCloudConnector Node installed, you need to get the Node URL from your service provider or system administrator.You then register the Node with your vCloud Connector Server using the Node URL and your ownOrganization credentials.
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Install vCloud Connector Node in vSphereYou can install a vCloud Connector Node in vSphere 4.0, 4.1, 5.0, or 5.1.
 Prerequisites
 You must have administrator-level access on the vSphere in which you install the vCloud Connector Node.You must have the unzipped version of the template you downloaded in “Download the vCloud ConnectorVirtual Appliances,” on page 18.
 Procedure
 1 Log on to vSphere Client.
 2 Select File > Deploy OVF template.
 3 Click Browse and navigate to the OVF directory of the Node zip file you downloaded to your desktop in“Download the vCloud Connector Virtual Appliances,” on page 18.
 4 Click Next.
 5 Proceed through the wizard.
 You can either use the Networking Properties step in the wizard to set basic network properties or youcan wait and set those properties when you configure your server. Set proxy information during theconfiguration step.
 NOTE If you are going to use a static IP address, you need to assign it here.
 6 In vSphere Client, select Inventory > VMs and Templates to see the created virtual machine in thehierarchy tree.
 7 Right-click the virtual machine and select Power > Power on to power on the machine.
 8 Click the Summary tab and find the vCloud Connector Node's IP address in the General section. The IPaddress field (not the Host field) displays the IP address of the Node. Make a note of the IP address. Youwill need it later in the process.
 Install vCloud Connector Node in vCloud Director 1.5You install a vCloud Connector Node in each vCloud Director 1.5 cloud you want to connect to and use withvCloud Connector.
 If you are a public vCloud service provider hosting many organizations or if you have a private vCloud Directorcloud with many organizations, you can choose to install one vCloud Connector Node in the cloud, instead ofinstalling a Node for each organization. A single vCloud Connector Node can be used by multipleorganizations on the cloud to transfer content to and from the cloud.
 If you are a service provider or the system administrator of a vCloud Director cloud and you choose to installa vCloud Connector Node for multiple organizations to use, you need to
 n Install a Node on the cloud.
 n Configure the Node.
 n Provide information about the Node (the Node URL) to each organization that will use it.
 If you are a user, that is, an organization, of a private or public vCloud Director cloud, you need to
 n Check with your service provider or system administrator if a vCloud Connector Node is already deployedon the cloud that you can use.
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n If a Node is already deployed on the cloud, you need to get information about the Node (the Node URL)from the service provider or system administrator. You require this information to register the Node withyour vCloud Connector Server.
 n If a vCloud Connector Node is not already deployed on the cloud, follow the procedures in this sectionto install a Node for your organization.
 Procedure
 1 Add the vCloud Connector Node to a vCloud Director 1.5 Catalog as a vApp Template on page 30Before you can deploy a vCloud Connector Node in a vCloud Director 1.5 cloud, you must upload thevirtual appliance to a catalog as a vApp Template. If the template has already been uploaded and put ina master catalog shared by multiple organizations, you can skip this step.
 2 Create the vCloud Connector Node from the Template in a vCloud Director 1.5 Cloud on page 31After the vCloud Connector Node is added to the vCloud Director 1.5 cloud as a template, you can useit to create a running instance on that cloud.
 3 Set Up NAT Mapping for vCloud Connector Node in vCloud Director 1.5 on page 32If you select a NAT-based network connection when you deploy your vCloud Connector Node, you needto set up NAT mapping and firewall rules.
 Add the vCloud Connector Node to a vCloud Director 1.5 Catalog as a vApp TemplateBefore you can deploy a vCloud Connector Node in a vCloud Director 1.5 cloud, you must upload the virtualappliance to a catalog as a vApp Template. If the template has already been uploaded and put in a mastercatalog shared by multiple organizations, you can skip this step.
 Prerequisites
 You must have System Administrator or Organization Administrator access on the vCloud Director cloud onwhich you install the vCloud Connector Node. You must have the unzipped version of the template youdownloaded in “Download the vCloud Connector Virtual Appliances,” on page 18.
 Procedure
 1 Log on to the vCloud Director Web console using a supported browser.
 2 Click Catalogs.
 If you log on as System Administrator, select your organization first, then click the Catalogs tab.
 3 Double-click the catalog to which you want to upload the vCloud Connector Node, then click the vAppTemplates tab.
 4 Click the Upload icon.
 5 In the Upload OVF package as a vApp Template dialog box, click Browse, accept the security certificateif you are prompted to do so, and select the Node OVF file that you downloaded.
 6 Specify a name and, optionally, a description, for the vApp template.
 7 Select the virtual datacenter and catalog for the template.
 8 Click Upload.
 The upload process begins. You can monitor the status of the upload in the Transfer Progress popup.
 NOTE It may take several seconds after the upload itself has finished for the process to finalize in the cloud.
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Create the vCloud Connector Node from the Template in a vCloud Director 1.5 CloudAfter the vCloud Connector Node is added to the vCloud Director 1.5 cloud as a template, you can use it tocreate a running instance on that cloud.
 Prerequisites
 You have System Administrator or Organization Administrator access on the vCloud Director on which youinstall the vCloud Connector Node.
 Procedure
 1 In the vApp Templates tab of the catalog to which you uploaded, right-click the name of your vCloudConnector Node template and select Add to My Cloud.
 The Add to My Cloud popup appears.
 2 Give the Node vApp an easily identifiable name and provide a description.
 3 Set the leases for the Node vApp, then click Next.
 4 Read and accept the EULA, and click Next.
 5 Select an appropriate network from the Network drop-down menu.
 Unless all the Nodes controlled by your vCloud Connector Server are behind the same firewall, you needto select a network that is configured to access the Internet. Ask your Service Provider or NetworkAdministrator for more information.
 6 Select the appropriate IP Assignment from the drop-down menu and click Next.
 If there is a static IP pool, that is probably a reasonable choice. Ask your Service Provider or NetworkAdministrator for more information. If your provider uses NAT, you will need to set up NAT mappingafter your Node is deployed. See “Set Up NAT Mapping for vCloud Connector Node in vCloud Director1.5,” on page 32.
 7 In the Networking Properties page, use the information you collected before you began installing vCloudConnector to specify the DNS server, IP address, Netmask, and Default Gateway. If you are using DHCP,leave the fields blank.
 8 In the Configure Networking page, leave both check boxes unchecked and click Next.
 9 In the Ready to Complete page, review the settings and click Finish.
 10 Click the My Cloud tab, then select vApps in the My Cloud panel.
 You see the vApp being created.
 11 In the My Cloud panel, select VMs, then right-click your vCloud Connector Node virtual machine andselect Properties.
 12 On the Virtual Machine Properties page, click the Guest OS Customization tab.
 13 Check Enable guest customization, then click OK.
 14 In the My Cloud panel, select vApps, then right-click the console icon of the vCloud Connector Node andselect Start.
 15 When the vCloud Connector Node on vCloud Director 1.5 is in running state, click VMs in the My Cloudpanel and make a note of the IP address of the vCloud Connector Node virtual machine.
 You need the IP address later in the registration process.
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Set Up NAT Mapping for vCloud Connector Node in vCloud Director 1.5If you select a NAT-based network connection when you deploy your vCloud Connector Node, you need toset up NAT mapping and firewall rules.
 There are multiple approaches to managing this issue. Decide whether you wish to use NAT to forward onlythe ports necessary for vCloud Connector operation or to forward all ports and then set up a firewall rule tofilter all but the following required ports:
 n Port 443: For communication between vCloud Connector Server and Nodes and between Nodes. This portis used when SSL is enabled; when SSL is disabled, port 80 is used.
 n Port 5480: For communication with the vCloud Connector Node Admin Web console, for example duringthe registration process.
 Prerequisites
 Your appliance is deployed and you are logged on to the vCloud Director Web console.
 Procedure
 1 Click the Administration tab and select Networks in the left panel.
 2 Find the network you are using in the Networks list, right-click and select Configure Services.
 3 In the Configure Services dialog box, click the NAT Mapping tab and click Add at the bottom of the tabto create the NAT rule.
 The Add NAT Rule popup appears.
 4 Select one of the External IP addresses from the drop-down list.
 Note this address if you plan to set up a firewall rule.
 5 If you wish to NAT all ports, enter * for the first port entry.
 If you wish to NAT only the required ports, create a rule for each port.
 6 Enter the internal IP address from your initial setup and match the port entry for this rule.
 7 Click OK and click OK again.
 8 If you are using a firewall rule to control traffic, click the Firewall tab and select the Enable firewall checkbox.
 9 Click Add at the bottom of the pop-up to create a new firewall rule.
 Create a rule for each necessary port.
 The Add Firewall Rule popup appears.
 10 Give the rule a name and select the Incoming radio button.
 11 Type the source IP address and the source port.
 For incoming traffic, the source is the external network. This is the address you selected in Step 4 above.
 12 Type the destination IP address and port.
 The destination IP address is the internal IP address from your initial setup.
 13 Select the Allow option.
 14 Select the Enabled option.
 15 Click OK and OK to create the rule.
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Install vCloud Connector Node in vCloud Director 5.1You install a vCloud Connector Node in each vCloud Director 5.1 cloud you want to connect to and use withvCloud Connector.
 If you are a public vCloud service provider hosting many organizations or if you have a private vCloud Directorcloud with many organizations, you can choose to install one vCloud Connector Node in the cloud, instead ofinstalling a Node for each organization. A single vCloud Connector Node can be used by multipleorganizations on the cloud to transfer content to and from the cloud.
 If you are a vCloud Service Provider or the system administrator of a vCloud Director cloud and you chooseto install a vCloud Connector Node for multiple organizations to use, you need to
 n Install a vCloud Connector Node on the cloud.
 n Configure the Node.
 n Provide information about the Node (the Node URL) to each organization that will use it.
 If you are a user, that is, an organization, of a vCloud Director private or public cloud, you need to
 n Check with your service provider or system administrator if a vCloud Connector Node is already deployedon the cloud that you can use.
 n If a vCloud Connector Node is already deployed on the cloud, you need to get information about the Node(the Node URL) from the service provider or system administrator. You require this information to registerthe Node with your vCloud Connector Server.
 n If a vCloud Connector Node is not already deployed on the cloud, follow the procedures in this sectionto install a Node for your organization.
 1 Add the vCloud Connector Node to a vCloud Director 5.1 Catalog as a vApp Template on page 33Before you can deploy a vCloud Connector Node in a vCloud Director 5.1 cloud, you must upload it toa catalog as a vApp template. If the template has already been uploaded and put in a master catalogshared by multiple organizations, you can skip this step.
 2 Create the vCloud Connector Node from the Template in a vCloud Director 5.1 Cloud on page 34After the vCloud Connector Node is added to the vCloud Director 5.1 cloud as a template, you can useit to create a running instance on that cloud.
 3 Set Up NAT Mapping for vCloud Connector Node in vCloud Director 5.1 on page 35If you select a NAT-based network connection when you deploy your vCloud Connector Node, you needto set up NAT mapping and firewall rules.
 Add the vCloud Connector Node to a vCloud Director 5.1 Catalog as a vApp TemplateBefore you can deploy a vCloud Connector Node in a vCloud Director 5.1 cloud, you must upload it to a catalogas a vApp template. If the template has already been uploaded and put in a master catalog shared by multipleorganizations, you can skip this step.
 Prerequisites
 You must have System Administrator or Organization Administrator access on the vCloud Director cloud onwhich you install the vCloud Connector Node.
 Procedure
 1 Log on to the vCloud Director Web console using a supported browser.
 2 Click Catalogs.
 If you log on as System Administrator, select your organization first, then click the Catalogs tab.
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3 Select the catalog to which you want to upload the vCloud Connector Node, then click the vAppTemplates tab.
 4 Click the Upload icon.
 5 In the Upload OVF package as a vApp Template popup, click Browse and select the Node OVF file thatyou downloaded.
 6 Specify a name and, optionally, a description, for the vApp template.
 7 Select the virtual datacenter, catalog, and storage profile for the template.
 8 Click Upload.
 The upload process begins. You can monitor the status of the upload in the Transfer Progress popup.
 NOTE It may take several seconds after the upload itself has finished for the process to finalize in the cloud.
 Create the vCloud Connector Node from the Template in a vCloud Director 5.1 CloudAfter the vCloud Connector Node is added to the vCloud Director 5.1 cloud as a template, you can use it tocreate a running instance on that cloud.
 Prerequisites
 You have System Administrator or Organization Administrator access on the vCloud Director cloud on whichyou install the vCloud Connector Node.
 Procedure
 1 In the vApp Templates tab of the catalog to which you uploaded the vCloud Connector Node, right-clickthe name of the Node template and select Add to My Cloud.
 2 Read and accept the EULA and click Next.
 3 Give the Node vApp an easily identifiable name, provide a description, and click Next.
 Default lease information is displayed; you can modify the leases later through the vApp propertiessettings.
 4 In the Configure Resources page
 a Select the virtual datacenter in which to store the Node vApp.
 b Provide a name for the virtual machine.
 c Select a Storage Profile.
 d Click Next.
 5 Select an appropriate network from the Destination drop-down menu.
 Unless all the vCloud Connector Nodes controlled by your vCloud Connector Server are behind the samefirewall, you need to select a network that is configured to access the Internet. Ask your Service Provideror Network Administrator for more information.
 6 Select the appropriate IP Allocation from the drop-down menu and click Next.
 If there is a static IP pool, that is probably a reasonable choice. Ask your Service Provider or NetworkAdministrator for more information. If your provider uses NAT, you will need to set up NAT mappingafter your Node is deployed. See “Set Up NAT Mapping for vCloud Connector Node in vCloud Director5.1,” on page 35.
 7 In the Networking Properties page, use the information you collected before you began installing vCloudConnector to specify the DNS server, IP address, Netmask, and Default Gateway. If you are using DHCP,leave the fields blank.
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8 In the Ready to Complete page, review the settings and click Finish.
 9 Click the My Cloud tab, then select vApps in the My Cloud panel.
 You see the vApp being created.
 10 After the vApp is created, select VMs in the My Cloud panel, right-click your vCloud Connector Node,and select Properties.
 11 In the Virtual Machine Properties page, click the Guest OS Customization tab.
 12 Check Enable guest customization.
 13 Click OK.
 14 In the My Cloud panel, select vApps, then right-click the console icon of your Node and select Start.
 15 When the Node is in running state, select VMs in the My Cloud panel and make a note of the IP addressof your Node.
 You need the IP address later in the registration process.
 Set Up NAT Mapping for vCloud Connector Node in vCloud Director 5.1If you select a NAT-based network connection when you deploy your vCloud Connector Node, you need toset up NAT mapping and firewall rules.
 There are multiple approaches to managing this issue. Decide whether you wish to use NAT to forward onlythe ports necessary for vCloud Connector operation or to forward all ports and then set up a firewall rule tofilter all except the following required ports:
 n Port 443: For communication between vCloud Connector Server and Nodes and between Nodes. This portis used when SSL is enabled; when SSL is disabled, port 80 is used.
 n Port 5480: For communication with the vCloud Connector Node Admin Web console, for example duringthe registration process.
 Prerequisites
 Your appliance is deployed and you are logged on to the vCloud Director Web console.
 Procedure
 1 Click the Administration tab and select Virtual Datacenters in the left panel.
 2 Double-click your virtual datacenter.
 3 Click the Org vDC Networks tab.
 4 Find the network you are using in the list of networks, right-click, and select Configure Services from thepopup menu.
 5 Click the NAT tab.
 6 Click Add DNAT to add the rule.
 The Add Destination NAT Rule form appears.
 7 Specify the external IP address.
 8 If you wish to NAT all ports, enter * for the first port entry.
 If you wish to NAT only the required ports, create a rule for each port.
 9 Enter the internal IP address from your initial setup and match the port entry for this rule.
 10 Click OK and click OK again.
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11 If you are using a firewall rule to control traffic, click the Firewall tab and select the Enable firewall checkbox.
 12 Click Add at the bottom of the page to create a new firewall rule.
 Create a rule for each required port.
 The Add Firewall Rule popup appears.
 13 Select the Enabled check-box.
 14 Give the rule a name.
 15 Type the source IP address and the source port.
 For incoming traffic, the source is the external network. This is the address you selected in Step 7 above.
 16 Type the destination IP address and port.
 The destination IP address is the internal IP address from your initial setup.
 17 Select the protocol.
 18 Select Allow.
 19 Click OK and OK to create the rule.
 Register vCloud Connector Nodes with CloudsAfter you install a vCloud Connector Node, you need to register it with the cloud on which it is installed.
 In a public or private vCloud Director environment in which one vCloud Connector Node is deployed for useby multiple organizations in the cloud, the system administrator of the cloud performs this task.
 Prerequisites
 The vCloud Connector Node is powered on and you have its IP address.
 Procedure
 1 Go to the vCloud Connector Node Admin Web console at https://<vCCNode_IP_address>:5480.
 2 Log on as admin. If you have not changed the password, use vmware, the default password.
 3 Click the Node tab, then the Cloud tab.
 4 In the Cloud Type field, select the type of cloud in which the vCloud Connector Node is installed: vSphereor vCloud Director.
 5 In the Cloud URL field, specify the URL of the cloud in which the vCloud Connector Node is installed.You can specify either the IP address of the cloud or its fully qualified domain name (FQDN):
 u https://<Cloud_IPaddress>
 For example: https://10.10.100.10
 u https://<Fully_Qualified_Domain_Name_of_Cloud>
 For example: https://cloud1.company.com
 6 Select Ignore SSL Certificate if the cloud does not have a valid SSL certificate.
 7 Select Use Proxy if there is an HTTP proxy server between the vCloud Connector Node and the cloud.
 NOTE If you select this option, you must also specify proxy settings in the Network - Proxy tab.
 8 Click Update Configuration.
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The vCloud Connector Node is registered with the cloud on which it is installed.
 What to do next
 Configure your vCloud Connector Node by using the settings in the other tabs of the vCloud Connector NodeAdmin Web console.
 Configure vCloud Connector NodesYou use the vCloud Connector Node Admin Web console for each of your Nodes to do basic configurationtasks, such as defining your time zone, specifying proxy servers, or setting log levels. What you need to dodepends on your particular installation.
 The vCloud Connector Node Admin Web console interface is divided into four tabs: System, Network, Update,and Node.
 Prerequisites
 The vCloud Connector Node instance is running and you have the IP address for it that you wrote down whenyou installed it. You have the information you collected in “Collect Necessary Information,” on page 14.
 Procedure
 1 Go to the vCloud Connector Node Admin Web console at https://<Node_IPaddress>:5480.
 2 If you receive a certificate warning, accept the certificate.
 3 Log on to the Node Admin Web console as admin.
 The default password is vmware.
 Check the Web console title to make sure you are configuring the vCloud Connector Node.
 4 Use the information you collected to complete general configuration as needed.
 5 When you finish the general configuration tasks, you can exit the vCloud Connector Node Admin Webconsole.
 System Tab - NodeThe System tab provides general information on the virtual appliance, allows you to set time zones, and letsyou shut down and reboot the appliance.
 InformationThe Information tab provides general information on the virtual appliance, such as the version number andthe host name. It also contains the Reboot and Shutdown buttons.
 Time ZoneThe Time Zone tab allows you to set your local time zone. Click System Time Zone to see a drop-down listdisplaying time zones of the world. Select a time zone and click Save Settings.
 NOTE Changes in time zone settings are not reflected in logs, etc. until the service is reset. Click Reboot in theInformation tab to restart.
 The virtual hardware clock is always maintained in UTC, which the virtual appliance converts to local time.Correct local time is important for the update repository and VMware Update Manager.
 Chapter 4 Installing vCloud Connector
 VMware, Inc. 37

Page 38
                        

Network Tab - NodeOn the Network tab, you can view network related information about the appliance, switch between DHCPand static IP addresses, and set up proxy information.
 StatusThe Network Status tab provides already configured network information about your appliance, such as DNSservers, network interfaces, and IP addresses. Click Refresh to update your information.
 AddressThe Network Address Settings tab allows you to specify static IP information for your appliance or to retrieveIP settings from a DHCP server.
 NOTE If you set a static IP address you must make sure that there are values for all of the displayed fields. InvCloud Director installations, you must set Preferred and Alternate DNS servers manually. Talk to your ServiceProvider or Network Admin for the appropriate addresses. You recorded the information that you need forthese settings in “Collect Necessary Information,” on page 14.
 For more information about network paths in data transfers, see Chapter 7, “Cross-Cloud Data Transfer andNetwork Connectivity,” on page 55.
 Click Save Settings to accept any changes that you made to the network address settings. Click CancelChanges to discard the changes.
 NOTE If you are using static IP settings, and you update the hostname and IP settings at the same time, onlythe IP settings are saved. The hostname is not saved. Update the Hostname field separately.
 Also note that if you change the IP address, you will not see your changes until you log out and log back in tothe Admin Web console using the new IP address.
 ProxyThe Proxy Settings tab allows you to set up any necessary proxy settings, including address and port. Set thisif the appliance must use a proxy to reach systems beyond the firewall at the installation location.
 You recorded the information that you need for these settings in “Collect Necessary Information,” onpage 14.
 Click Save Settings to accept any changes that you made to the proxy settings. Click Cancel Changes to discardthe changes.
 Update Tab - NodeThe Update tab allows you to check the update status of your virtual appliance and to set your update policy.
 StatusThe Status section allows you to view information about your virtual appliance or to check for and installupdates. Click Check Updates to check for updates from the update repository, shown in the AvailableUpdates pane. Click Install Updates to install the updates.
 SettingsThe Update Settings section allows you to determine when you want to check for updates. You should leavethe Use Default Repository button selected. Save any changes you make by clicking Save Settings.
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Node TabOn the Node tab you can change the vCloud Connector Node administrator password, adjust log levels, andmanage SSL certificates. You also use this tab to register the vCloud Connector Node with the cloud on whichit is installed.
 CloudIn the Cloud Registration section, you register the vCloud Connector Node with the cloud on which it isinstalled.
 NOTE For public or private vCloud Director clouds that have only one vCloud Connector Node installed foruse by multiple organizations, this task is performed by the service provider or network administrator of thecloud.
 Cloud Type The type of cloud on which the vCloud Connector Node is installed.
 Cloud URL The URL of the cloud on which the vCloud Connector Node is installed, in the following format:https://<IP Address of vSphere or vCloud Director cloud>.
 Ignore SSL Cert Select this option if the cloud does not have a valid SSL certificate.
 Use Proxy Select this option if there is an HTTP proxy server between the vCloud Connector Node and the cloud.If you select this option, you must also specify proxy settings in the Network - Proxy tab.
 GeneralThe General Settings section allows you to change the administrator password for the vCloud ConnectorNode, set log file severity levels, and download log files. Change admin userpassword
 Specify a new administrator password for the vCloud Connector Node, then click Confirm newpassword. You should change the default password.
 Log levels Set the severity level for vCloud Connector Node log files, then click Change log level.
 Download logs Click to download a zip file of vCloud Connector Node log files. If you are using a Node that hasbeen deployed by a public vCloud Service Provider or private vCloud Director cloud systemadministrator for use by multiple organizations and you do not have access to the Node, you candownload your log files from the vCloud Connector Server Admin Web console.
 Concurrent TasksConfiguration
 Specify the maximum number of concurrent tasks that are allowed for the vCloud Connector Node,then click Change Maximum Concurrent Tasks. The default is 10.Note that if you increase the concurrent tasks maximum, you should also increase the vCloudConnector Node storage. The amount of storage you need depends upon the size of your tasks.Approximately 50GB is recommended for each added task.See “Increase Maximum Concurrent Tasks,” on page 47 and “Configure vCloud Connector NodeAllocated Storage,” on page 45 for more information.
 SSLThe Manage SSL Certificates section allows you to disable or enable SSL and to manage your certificates.vCloud Connector Node has SSL enabled by default and includes a self-signed certificate. Before going intoproduction, replace the certificate with a valid certificate. Disable SSL/EnableSSL
 Select Disable SSL if you want to disable HTTPS communication. Note that if you disable SSL,the port that vCloud Connector Node uses changes from 443 to 80.
 Key Info Displays information about the default key provided.
 Certificate Info Displays information about the self-signed certificate that is provided with vCloud ConnectorNode.
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Generate New Key If you need to generate a new private key to obtain a valid certificate from your Certificate
 Authority, type the required information and click Generate Key.NOTE Fields in this section do not support multi-byte characters. Use only ASCII characters forthe values you enter. If you enter non-ASCII characters, a garbled value is displayed.
 Generate anddownload CSR
 Click to create a Certificate Signing Request and save it to your computer. Use the savedhcagent.csr file to get a certificate from your Certificate Authority.
 Upload a new X.509 SSLCertificate
 Once you have your certificate, use the Browse button to locate it, then click Upload.
 For more information on installing a valid certificate, see “Add Valid SSL Certificates,” on page 43.
 Register vCloud Connector Nodes with vCloud Connector ServerYou use the vCloud Connector Server Admin Web console to register vCloud Connector Nodes with thevCloud Connector Server. The Nodes are installed on vSphere, private vCloud Director clouds, or publicvClouds. The registration allows the Server to manage the Nodes.
 Procedure
 1 Go to the vCloud Connector Server Admin Web console at https://<vCC Server IP address>:5480.
 If you receive a certificate error, accept the certificate. vCloud Connector Server has a self-signed certificate.
 2 Log on to the Web console as admin.
 If you did not change the password, use vmware, the default password.
 3 Click the Nodes tab.
 The Manage Nodes tab contains the list of vCloud Connector Nodes that are currently registered.
 The Local Content Directory Node always appears by default. This node is for Content Sync. Do not editthis Node.
 4 Click Register Node.
 5 Complete the Node information.
 Node Info Option Description
 Name Name of the cloud where the vCloud Connector Node is installed. This nameis the display name of the cloud in the vCloud Connector UI.
 Description A description of the vCloud Connector Node. For example, you can specifywhether the Node is a service provider Node or a local Node, or provideinformation about whom to contact if there are any issues.
 URL The URL of the Node. You can specify either the IP address of the Node orits fully qualified domain name (FQDN):n https://<vCCNode_IPaddress>
 For example: https://10.10.100.10n https://<Fully_Qualified_Domain_Name_of_vCCNode>
 For example: https://node1.company.comYou can get the URL of the vCloud Connector Node from its console in thevSphere or vCloud Director cloud in which it is installed. If the Node is ona public vCloud, obtain this information from your service provider.
 Public Select if the cloud is a public cloud outside the firewall where your vCloudConnector Server is installed.
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Node Info Option Description
 Use Proxy Select if the vCloud Connector Server needs to use a proxy to reach thevCloud Connector Node that you are registering.
 Ignore SSL Certificate Select if you did not install valid certificates.NOTE If you did not install valid certificates, and you do not select this option,copying fails. If you select this option, and later install a valid certificate, youmust deselect this option and restart the vCloud Connector server.
 6 Complete the cloud information.
 Cloud Info Option Description
 Cloud Type Type of cloud on which the vCloud Connector Node is installed, eithervSphere or vCloud Director.
 vCD Org Name If the vCloud Connector Node is on a vCloud Director cloud, type the nameof your organization. You must use a valid organization name. vCloudConnector validates the organization name that you provide with the cloud.If you selected vSphere in the Cloud Type option, this field is disabled.
 Username User name for the cloud in which the vCloud Connector Node is installed.
 Password Password for the cloud in which the vCloud Connector Node is installed.
 7 Click Register.
 The Register Node with Server window closes and the vCloud Connector Node appears in the ManageNodes list. To edit values, unregister the Node, or to download log files for a Node, click the gears icon at theright of the list entry.
 NOTE Do not update or unregister a vCloud Connector Node while a task is in progress.
 Register the vCloud Connector UIYou can register the vCloud Connector UI to appear in your vSphere Client, vcloud.vmware.com, or both.
 Register the vCloud Connector UI in vSphere ClientSet up the vCloud Connector UI as a plug-in in vSphere Client using the vCloud Connector Server Admin Webconsole.
 You can register your vCloud Connector UI with only one vSphere Client at a time. To register with anothervSphere Client, unregister and then register with the new vSphere Client. Also, a vSphere Client can have onlyone vCloud Connector instance as a plug-in. To replace it, select the Overwrite existing registration optionwhile registering.
 NOTE Because the vSphere Client interface uses the Internet Explorer rendering engine, it also uses the InternetExplorer security and privacy settings. Set your settings at Medium High or below. This setting allows cookiesand Javascript, both of which are necessary for the plug-in to work.
 Prerequisites
 You need the information you collected in “Collect Necessary Information,” on page 14. You need the IPaddress of the vCloud Connector Server and the IP address or fully qualified domain name of the vCenterServer to which the vSphere Client is pointed. You also need an administrator username and password forthat vCenter Server.
 Procedure
 1 Go to the vCloud Connector Server Admin Web Console at https://<vCC Server IP Address>:5480.
 Chapter 4 Installing vCloud Connector
 VMware, Inc. 41

Page 42
                        

2 If you get a certificate error, accept the certificate.
 3 Log on as admin.
 If you have not changed the password, use vmware, the default password.
 4 Click the Server tab, then the vSphere Client tab.
 5 Type the vCloud Connector Server URL in the following format: https://<vCC Server IP address>.
 If you are using DHCP, the vCC Server URL text box is automatically populated.
 6 Type the vCenter Server IP address or fully qualified domain name.
 NOTE If your vCenter Server is running on a port other than the default, make sure you indicate the portalong with the IP address.
 7 Type the user name and password for the vCenter Server.
 8 If you have a previously registered version of the vCloud Connector Server that you are replacing withthis current version, select Overwrite existing registration.
 9 Click Register.
 To unregister a previous registration, click Unregister. To update an existing registration, click UpdateRegistration.
 When the registration is completed, a confirmation message appears at the top of the section.
 If you get an error, check the values you entered in the fields. If you did not enter an administrator usernameand password for the vCenter Server, you will get the following error: "Could not register the plugin: Couldnot connect to https://<IPaddress>."
 Register the vCloud Connector UI with the vcloud.vmware.com Website
 NOTE If you have registered a vCloud Connector Server with the website, and you wish to install a new versionof vCloud Connector, you should unregister the current Server from the website before you install the newServer. (If you do not do so, the old Server remains registered with vcloud.vmware.com. For information onhow to remove it, see Remove a vCloud Connector Server in Using vCloud Connector.) You can still register anduse the new Server, but you will have to select that new Server using the Settings page in the website.
 Prerequisites
 You need to know the IP address of the vCloud Connector Server. You also need to know the vmware.comaccount username and password you want to use to access the vCloud Connector UI throughvcloud.vmware.com.
 Procedure
 1 Go to the vCloud Connector Server Admin Web Console at https://<vCC Server IP Address>:5480.
 2 If you get a certificate error, accept the certificate.
 3 Log on as admin.
 If you have not changed the password, use vmware, the default password.
 4 Click the Server tab, then the vcloud.vmware.com tab.
 5 Specify the name by which you want your vCloud Connector Server to appear at the vcloud.vmware.comwebsite.
 6 Specify the vCloud Connector Server URL in the following format: https://<vCC Server IP Address>.
 If you are using DHCP, the vCloud Connector Server URL textbox is automatically populated.
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7 Specify the vmware.com email address and password that you want to use to access the vCloud ConnectorUI through vcloud.vmware.com.
 8 To create a new registration, click Register. To unregister a previous registration, click Unregister. Toupdate an existing registration, click Update Registration.
 When the registration is completed, a confirmation message appears at the top of the section.
 Prepare vCloud Connector for Production UseBefore you place vCloud Connector into production use, you must prepare it for a full production environment.
 Procedure
 1 Add Valid SSL Certificates on page 43If you have not yet replaced the self-signed certificates in your vCloud Connector Server and vCloudConnector Nodes, you need to do so before production use.
 2 Add Multiple Intermediate Certificates on page 44The vCloud Connector Server and vCloud Connector Node Admin Web consoles support uploadingonly a single root, intermediate, and signed certificate. To upload multiple root and intermediatecertificates you must use the command line interface.
 3 Configure vCloud Connector Node Allocated Storage on page 45Copy operations rely on staging storage when you copy resources between clouds. To successfully copyresources, make sure you have enough storage in your vSphere and vCloud Director clouds.
 4 Increase Maximum Concurrent Tasks on page 47In vCloud Connector, you can start multiple tasks at the same time. By default, vCloud Connectorexecutes a maximum of 10 concurrent tasks per vCloud Connector Node, that is, per cloud. If you specifymore than 10 tasks, the first 10 tasks are executed concurrently. When a task finishes, the next one in thequeue is executed.
 Add Valid SSL CertificatesIf you have not yet replaced the self-signed certificates in your vCloud Connector Server and vCloud ConnectorNodes, you need to do so before production use.
 In a production environment, vCloud Connector requires root, intermediate, and signed certificates for thevCloud Connector Server and Nodes. All three certificates are required. The certificates must be in the X.509format.
 From the vCloud Connector UI, you can upload a root, intermediate, and signed certificate. To upload multiplecertificates, use the command line interface. Also use the command line interface to upload fewer than threecertificates (if your Certificate Authority only issues two certificates, for example). See “Add MultipleIntermediate Certificates,” on page 44 for more information.
 Procedure
 1 Log on to the Admin Web console of the vCloud Connector Server or Node whose certificate you are goingto replace as admin.
 If you have not changed the password, use vmware, the default password.
 2 For vCloud Connector Server, click on the Server tab, then click on the SSL tab. For vCloud ConnectorNode, click on the Node tab, then click on the SSL tab.
 3 If you need to create a new private key, in the Generate New Key section of the Manage SSL Certificatespage, specify
 n The key algorithm you want to use
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n The key size
 n Your company information
 Whether you need to create a new private key depends upon your Certificate Authority (CA); contactyour CA for more information.
 NOTE Use only ASCII characters in the fields. If you use non-ASCII characters, they appear garbled.
 4 Click Generate Key.
 5 Click Generate and download CSR to generate a Certificate Signing Request and download it.
 The vCloud Connector Server file is named hcserver.csr; the vCloud Connector Node file is namedhcagent.csr.
 6 Obtain certificates from your CA using the .csr files you downloaded.
 7 If the certificates you obtain from your CA are not in X.509 format, convert the certificates to the X.509format by using the following command at the command prompt:
 openssl pkcs7 -in <path/../certificate.cer> -print_certs | openssl x509 >
 <path/../certificate.cer>
 NOTE You must have the OpenSSL library installed to access this command.
 8 When you have your certificates in the X.509 format,
 a In the Root CA certificate field, click Browse and find the root certificate for the vCloud ConnectorServer or Node.
 b In the Intermediate CA certificate field, click Browse and find the intermediate certificate for thevCloud Connector Server or Node.
 c In the Certificate field, click Browse and find the signed certificate for the vCloud Connector Serveror Node.
 d Click Upload.
 What to do next
 Once you have installed valid certificates, deselect the Ignore SSL Certificate flag in the Node registrationwindow for each Node. To change the flag, log on to the vCloud Connector Server Admin Web console, selectthe Nodes tab, then click the Actions icon for a Node and select Edit. See also “Register vCloud ConnectorNodes with vCloud Connector Server,” on page 40 for more information on this flag.
 You must restart the vCloud Connector Server after uploading new certificates for the change to take effect.
 Add Multiple Intermediate CertificatesThe vCloud Connector Server and vCloud Connector Node Admin Web consoles support uploading only asingle root, intermediate, and signed certificate. To upload multiple root and intermediate certificates you mustuse the command line interface.
 In a production environment, vCloud Connector requires root, intermediate, and signed certificates for thevCloud Connector Server and vCloud Connector Nodes. All three certificates are required. The certificatesmust be in the X.509 format.
 NOTE If your Certificate Authority only issues two certificates, you must upload both. Use the command lineto upload the certificates as the UI does not allow uploading fewer than three certificates.
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Procedure
 1 If the certificates that you obtained from your Certificate Authority are not in X.509 format, convert thecertificates to the X.509 format by using the following command at the command prompt:
 openssl pkcs7 -in <path/../certificate.cer> -print_certs | openssl x509 >
 <path/../certificate.cer>
 NOTE You must have the OpenSSL library installed to access this command.
 2 Log on to the console of the vCloud Connector Server (hcserver) or vCloud Connector Node (hcagent) asadmin. The default password is vmware.
 3 Switch to root: su root
 The default password is vmware.
 4 At the prompt, change directory to /usr/local/tcserver/vfabric-tc-server-standard/server_or_agent/conf
 5 Import the root certifcate.
 /usr/java/jre-vmware/bin/keytool -import -trustcacerts -alias root -file <location of
 root .cer file> -keystore tcserver.jks -storepass changeme
 6 Import intermediate certificates. Ensure that you import multiple intermediate certificates in an order ofsigning chain.
 /usr/java/jre-vmware/bin/keytool -import -trustcacerts -alias intermediate -file <location of
 intermediate .cer file> -keystore tcserver.jks -storepass changeme
 NOTE You must provide a unique alias name for every intermediate certificate you upload with this step.
 7 Import the signed certificate.
 /usr/java/jre-vmware/bin/keytool -import -trustcacerts -alias hcserver or hcagent -file
 <location of .cer file> -keystore tcserver.jks -storepass changeme
 What to do next
 Once you have installed the valid certificates, deselect the Ignore SSL Certificate option in the Noderegistration window for each Node. To change the flag, log on to the vCloud Connector Server Admin Webconsole, select the Nodes tab, then click the Actions icon for a Node and select Edit. See also “Register vCloudConnector Nodes with vCloud Connector Server,” on page 40 for more information on this flag.
 You must restart the vCloud Connector Server after you upload certificates for the change to take effect.
 Configure vCloud Connector Node Allocated StorageCopy operations rely on staging storage when you copy resources between clouds. To successfully copyresources, make sure you have enough storage in your vSphere and vCloud Director clouds.
 Default storage on vCloud Connector Nodes is 40 GB. You may need to increase this if you will be copyinglarge virtual machines or templates or if you will be copying many items simultaneously.
 You also need to increase the storage if you increase the maximum number of concurrent tasks allowed for aNode.
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Configure vCloud Connector Node Allocated Storage in vSphereTo successfully copy resources to or from a vSphere cloud, you must configure and resize the data diskassociated with the vCloud Connector Node for that vSphere cloud.
 Prerequisites
 n You are a vSphere administrator.
 n You have taken a snapshot of the virtual appliance.
 Procedure
 1 Log on to the vSphere Client.
 2 In the hierarchy tree, select the vCloud Connector Node virtual appliance.
 3 Right-click and select Edit Settings.
 The Virtual Machine Properties window opens to the Hardware tab.
 4 Select Hard disk 2 in the Hardware column.
 5 Modify the size, based on the size of the resources you are going to be transferring, and click OK.
 6 Open the console for the vCloud Connector Node.
 7 Run the following command to resize the disk:
 sudo /opt/vmware/hcagent/scripts/resize_disk.sh
 Configure vCloud Connector Node Allocated Storage in vCloud DirectorTo successfully copy resources to or from a vCloud Director cloud, you must add disk storage to the vCloudConnector Node associated with that cloud.
 To add disk storage in vCloud Director, you must add disks.
 Prerequisites
 You are a vCloud Director Org Administrator. You are logged on to vCloud Director.
 Procedure
 1 Power down the vCloud Connector Node.
 2 Click the My Cloud tab.
 3 Select VMs in the left panel.
 4 Right-click the console icon of the powered-down vCloud Connector Node in the center panel and selectProperties.
 5 In the Virtual Machine Properties popup, select the Hardware tab.
 6 Click the Add + button to add an additional disk to the Node.
 Size the disk based on the size of the resources you intend to transfer.
 7 Click OK to accept the change.
 8 Right-click the Node console icon and power on the Node.
 9 Right-click the Node console icon and select Popout Console.
 If you have not yet installed the VMware Remote Console plug-in, you are prompted to install it.
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10 Using the console, log on to the Node as admin.
 The default password is vmware.
 11 At the command prompt, type: .
 ls /dev/sd*
 A disk is created named something like "sdc".
 12 Run the following command to add the new disk.
 sudo /opt/vmware/hcagent/scripts/add_disk.sh <diskname>
 13 Log out of the console.
 Increase Maximum Concurrent TasksIn vCloud Connector, you can start multiple tasks at the same time. By default, vCloud Connector executes amaximum of 10 concurrent tasks per vCloud Connector Node, that is, per cloud. If you specify more than 10tasks, the first 10 tasks are executed concurrently. When a task finishes, the next one in the queue is executed.
 You can increase the maximum number of concurrent tasks for a vCloud Connector Node.
 If you increase the maximum number of concurrent tasks, you should also increase the storage allocated to theNode accordingly. The amount of extra storage you need depends upon the size of the resources you intendto transfer. About 50 GB is recommended for each added task.
 As most tasks, such as a copy task, involve both a source cloud and a destination cloud, the maximum numberapplies to both. If you increase the maximum so that you can execute more than 10 copies at a time, for example,increase the storage for the Node in both the source and destination cloud.
 Procedure
 1 Go to the vCloud Connector Node Admin Web console at https://<vCCNode_IPaddress>:5480.
 2 Log on as admin.
 The default password is vmware.
 3 Click the Node tab, then click the General tab.
 4 In the Concurrent Tasks Configuration section, type the maximum number of concurrent tasks, then clickChange Maximum Concurrent Tasks.
 5 Log out of the vCloud Connector Node Admin Web console.
 What to do next
 Increase the storage allocated for the vCloud Connector Node. See “Configure vCloud Connector NodeAllocated Storage,” on page 45.
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Entering the License Key for vCloudConnector Advanced Edition 5
 To enable advanced features available in vCloud Connector 2.0 Advanced edition (Content Sync andDatacenter Extension, also referred to as Stretch Deploy), you need to enter a valid vCloud Suite 5.1 licensekey.
 Prerequisites
 You have installed vCloud Connector. You have a valid vCloud Suite 5.1 license key.
 Procedure
 1 Go to the vCloud Connector Server Admin Web console at https://vCCServer_IPaddress:5480.
 You can get the IP address of the vCloud Connector Server from its console in the vSphere or vCloudDirector cloud in which you installed it.
 2 Log on as admin. If you have not changed the password, use vmware, the default password.
 3 Click the Server tab, then click the General tab.
 4 In the vCC License section, type the license key.
 5 Click Update Key.
 Advanced features in vCloud Connector are now enabled. You can access them in the vCloud Connector UI.
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Upgrading to vCloud Connector 2.0 6To upgrade to vCloud Connector 2.0 from version 1.5, follow the upgrade process described here.
 NOTE After you upgrade vCloud Connector, clear your browser cache before you use the upgraded version.You need to do this to ensure new data is shown in the vCloud Connector Server or Node Admin Web consolesor in the UI.
 This chapter includes the following topics:
 n “Upgrade to vCloud Connector 2.0 from the Admin Web Consoles,” on page 51
 n “Edit Hardware Settings for Upgraded vCloud Connector Server and Nodes on vSphere,” onpage 52
 n “Edit Hardware Settings for Upgraded vCloud Connector Server and Nodes on vCloud Director,” onpage 53
 n “Update Registration with vSphere Client,” on page 53
 Upgrade to vCloud Connector 2.0 from the Admin Web ConsolesTo upgrade to vCloud Connector 2.0, upgrade your vCloud Connector Server and all vCloud Connector Nodes.You upgrade a vCloud Connector Server or Node from its Admin Web console.
 Procedure
 1 Go to the vCloud Connector Server or Node Admin Web console at https://<vCCServer_IPaddress>:5480 orhttps://<vCCNode_IPaddress>:5480.
 You can get the IP address of the vCloud Connector Server or Node from its console in the vSphere cloudor vCloud Director cloud in which it is installed.
 2 Log on to the Admin Web console as admin.
 The default password is vmware.
 3 Click the Update tab, then click the Status tab.
 4 Click Check Updates.
 The available updates appear.
 5 Click Install Updates.
 6 Accept the EULA.
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7 Click OK in the confirmation dialog box.
 Wait for the update process to finish. When it finishes, a "System reboot is required to complete theupdate" message appears.
 8 Click the System tab.
 9 Click Reboot.
 You are logged out of the Admin Web console when the system finishes rebooting.
 What to do next
 Update the hardware settings for the upgraded vCloud Connector Server and Nodes. See
 n “Edit Hardware Settings for Upgraded vCloud Connector Server and Nodes on vSphere,” on page 52
 n “Edit Hardware Settings for Upgraded vCloud Connector Server and Nodes on vCloud Director,” onpage 53
 Edit Hardware Settings for Upgraded vCloud Connector Server andNodes on vSphere
 After you upgrade your vCloud Connector 1.5 Server and Nodes to vCloud Connector 2.0, update their virtualhardware settings to match those in vCloud Connector 2.0. The upgrade process does not change these settings.
 Follow this procedure for the upgraded vCloud Connector Server and for all upgraded vCloud ConnectorNodes that are installed on vSphere.
 Procedure
 1 Log on to the vSphere Client.
 2 Select Inventory > Hosts and Clusters.
 3 In the left pane, right-click your vCloud Connector Server or vCloud Connector Node virtual machineand select Power > Power Off to power it off.
 4 Right-click your vCloud Connector Server or vCloud Connector Node and select Edit Settings.
 5 In the Hardware tab, select Memory and increase the Memory Size to 3GB.
 6 Click OK.
 7 In the left pane, right-click your vCloud Connector Server or vCloud Connector Node virtual machineand select Power > Power On to power it on.
 What to do next
 Update the registration with the vSphere Client if your vCloud Connector 1.5 UI is registered as a plug-in invSphere Client. See “Update Registration with vSphere Client,” on page 53.
 Enter a license key if you want to use vCloud Connector 2.0 Advanced edition. See Chapter 5, “Entering theLicense Key for vCloud Connector Advanced Edition,” on page 49.
 Before you use the upgraded version of vCloud Connector, clear your browser cache.
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Edit Hardware Settings for Upgraded vCloud Connector Server andNodes on vCloud Director
 After you upgrade your vCloud Connector 1.5 Server and Nodes to vCloud Connector 2.0, update their virtualhardware settings to match the settings in vCloud Connector 2.0. The upgrade process does not change thesesettings.
 Follow this procedure for the upgraded vCloud Connector Server and all upgraded vCloud Connector Nodesthat are installed on vCloud Director.
 Procedure
 1 Log on to the vCloud Director cloud.
 2 Click My Cloud.
 3 In the My Cloud panel, select VMs.
 4 Select your vCloud Connector Server or vCloud Connector Node virtual machine and click the PowerOff icon to power it off.
 5 After it is powered off, right-click the vCloud Connector Server or Node virtual machine and selectProperties.
 6 Click the Hardware tab.
 7 In the Memory section, increase the memory to 3GB.
 8 Click OK.
 9 Select your vCloud Connector Server or vCloud Connector Node virtual machine and click the PowerOn icon to power it on.
 What to do next
 Update the registration with the vSphere Client if your vCloud Connector 1.5 UI is registered as a plug-in invSphere Client. See “Update Registration with vSphere Client,” on page 53.
 Enter a license key if you want to use vCloud Connector 2.0 Advanced edition. See Chapter 5, “Entering theLicense Key for vCloud Connector Advanced Edition,” on page 49.
 Before you use the upgraded version of vCloud Connector, clear your browser cache.
 Update Registration with vSphere ClientIf your vCloud Connector 1.5 UI is registered as a plug-in in vSphere Client, after you upgrade vCloudConnector 1.5 to vCloud Connector 2.0, update its registration with the vSphere Client.
 If you do not update the registration, vCloud Connector does not appear in the Solutions and Applicationspanel on the Home tab in vSphere Client.
 Prerequisites
 You have upgraded your vCloud Connector 1.5 Server and Nodes to version 2.0.
 Procedure
 1 Go to the vCloud Connector Server Admin Web console at https://<vCCServer_IPaddress>:5480.
 You can get the IP address of the vCloud Connector Server from its console in the vSphere cloud or vCloudDirector cloud in which it is installed.
 Chapter 6 Upgrading to vCloud Connector 2.0
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2 Log on as admin.
 The default password is vmware.
 3 Click the Server tab, then click the vSphere Client tab.
 4 Specify the vCenter user name and password, then click Update Registration.
 5 Log out of the Server Admin Web console.
 What to do next
 Enter a license key if you want to use vCloud Connector 2.0 Advanced edition. See Chapter 5, “Entering theLicense Key for vCloud Connector Advanced Edition,” on page 49.
 Before you use the upgraded version of vCloud Connector, clear your browser cache.
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Cross-Cloud Data Transfer andNetwork Connectivity 7
 vCloud Connector manages the transfer of content using a separate component, the vCloud Connector Node.Using Nodes allows multipart checkpoint-restart in transfers. This flow affects the way a request movesthrough the system and how network connectivity must be set up.
 Data Flow in TransferThe following graphic shows the path a vCloud Connector request takes in transferring data from a vSphereto a vCloud Director (VCD) cloud
 NOTE vCloud Connector uses port 443 when SSL is enabled and port 80 when SSL is disabled. By default, SSLis disabled for the vCloud Connector Server and enabled for vCloud Connector Nodes.
 Figure 7-1. Cross-cloud Data Flow
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 1 Customer requests transfer using vCloud Connector UI.
 2 vCloud Connector Server tells vCloud Connector Node to transfer vApp.
 3 Node tells vCenter Server to "export" using VIM API.
 4 Content is moved from datastores to source Node cache.
 5 Content is transferred from source to destination Node using checkpoint-restart.
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6 Destination Node calls the VCD API to "import".
 7 Content transfers from destination Node cache to VCD transfer server storage.
 8 VCD sends the command for the appropriate vCenter import.
 9 Content transfers from VCD transfer server storage to destination datastore network and is made availablethrough the VCD catalog.
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Uninstalling vCloud Connector 8To uninstall vCloud Connector, delete the vCloud Connector Server and all the vCloud Connector Nodesassociated with it. Before you delete the Server, you must unregister it from the vcloud.vmware.com websiteor the vSphere Client, or both, to which it is registered. Before you delete a Node, you must unregister it fromthe Server to which it is registered.
 This chapter includes the following topics:
 n “Uninstall a vCloud Connector Server,” on page 57
 n “Uninstall vCloud Connector Nodes,” on page 58
 Uninstall a vCloud Connector ServerTo uninstall vCloud Connector, unregister and delete the vCloud Connector Server and vCloud ConnectorNodes.
 Procedure
 1 Go to the vCloud Connector Server Admin Web console at https://vccServer_IPaddress:5480.
 You can get the IP address of the vCloud Connector Server from its console in the vSphere Client or vCloudDirector cloud in which it is installed.
 2 Log on as admin.
 If you did not change the password, use vmware, the default password.
 3 Unregister the vCloud Connector Nodes that are registered with the vCloud Connector Server.
 a Click the Nodes tab.
 b Click the gears icon next to the first cloud and select Unregister from the pop-up menu.
 c Click OK to confirm.
 d Repeat for all the clouds that are registered with the Server.
 4 If the vCloud Connector Server is registered with a vSphere client, unregister it from the client.
 a Click the Server tab, then click the vSphere Client tab.
 b Type the user name and password for the vSphere Client.
 c Click Unregister.
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5 If the vCloud Connector Server is registered with the vcloud.vmware.com Web site, unregister it from theWeb site.
 a Click the Server tab, then click the vcloud.vmware.com tab.
 b Type the vCloud Connector Server URL, if it is not already filled-in:
 https://<vCCServer_IP>
 c Type the email address and password for your vcloud.vmware.com account.
 d Click Unregister.
 6 Remove the Server from the vSphere or vCloud Director cloud in which it is installed.
 To remove the Server from a vSphere Client
 a Log on to the vSphere Client.
 b In the Inventory pane, select VMs and Templates.
 c Find your vCloud Connector Server virtual machine in the tree view.
 d Right-click your vCloud Connector Server virtual machine and select Power > Power Off from thepop-up menu.
 e When the vCloud Connector Server virtual machine is powered off, right-click on it again and selectDelete from Disk from the pop-up menu.
 To remove the Server from a vCloud Director cloud
 a Log on to the vCloud Director cloud.
 b Click the My Cloud tab.
 c In the My Cloud panel, select vApps.
 d Find your vCloud Connector Server vApp in the Name column, right-click it, and select Stop fromthe pop-up menu.
 e When the Status column displays Stopped for the vCloud Connector Server vApp, right-click it againand select Delete from the pop-up menu.
 f Click Yes to confirm.
 The vCloud Connector Server is now deleted. You cannot access vCloud Connector from the vSphere Clientor from vcloud.vmware.com.
 Uninstall vCloud Connector NodesYou can uninstall a vCloud Connector Node from a cloud if you no longer want to transfer content to and fromthat cloud. You must uninstall vCloud Connector Nodes when you uninstall vCloud Connector.
 Procedure
 1 Go to the vCloud Connector Server Admin Web console at https://vccServerIPaddress:5480.
 You can get the IP address of the vCloud Connector Server from its console in the vSphere Client or vCloudDirector cloud in which it is installed.
 2 Log on as admin.
 If you did not change the password, use vmware, the default password.
 3 Click the Nodes tab.
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4 Click the gears icon next to the vCloud Connector Node to delete, then select Unregister from the pop-upmenu.
 The Node is now unregistered from the Server.
 5 Repeat Step 4 for all the nodes you want to delete. If you are uninstalling vCloud Connector, delete all thenodes that are registered with the Server.
 6 Log on to the cloud in which the vCloud Connector Node is installed.
 7 If the vCloud Connector Node is installed on a vSphere cloud, delete it from the cloud.
 a In the Inventory pane, select VMs and Templates.
 b In the tree view, right-click the vCloud Connector Node virtual machine and select Power > PowerOff from the pop-up menu.
 c When the vCloud Connector Node virtual machine is powered off, right-click it again and selectDelete from Disk from the pop-up menu.
 8 If the vCloud Connector Node is installed on a vCloud Director cloud, delete it from the cloud.
 a Click the My Cloud tab.
 b In the My Cloud panel, select vApps.
 c Find your vCloud Connector Node vApp in the Name column, right-click it, and select Stop from thepop-up menu.
 d When the Status column shows Stopped for the vCloud Connector Node vApp, right-click it againand select Delete from the pop-up menu.
 e Click Yes to confirm.
 The vCloud Connector Node is deleted from the cloud. The cloud does not appear in the list of clouds in thevCloud Connector UI or the vcloud.vmware.com Web site.
 Chapter 8 Uninstalling vCloud Connector
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Troubleshooting vCloud Connector 9Use this information to troubleshoot problems with your vCloud Connector installation and its integrationwith vcloud.vmware.com.
 n Troubleshooting Storage on page 61If a transfer is interrupted in the middle, for example because of a network outage, temporary storage inthe Node might not be cleaned up, leading to a loss of usable storage space, even if the transfer completesnormally.
 n Troubleshooting Connectivity on page 61You can use cURL to pinpoint connectivity problems among the components of your vCloud Connectorinstallation.
 n Accessing Log Files from the UI on page 62You can access log files for a vCloud Connector Server or vCloud Connector Node instance from itsAdmin Web console.
 n Accessing Log Files from the Console on page 63You can access log files for a vCloud Connector Server or vCloud Connector Node instance through itsconsole.
 n Troubleshooting Log File Size on page 63To modify the size of log files or the number of files that are retained, you must modify the vCloudConnector Server or Node configuration files.
 Troubleshooting StorageIf a transfer is interrupted in the middle, for example because of a network outage, temporary storage in theNode might not be cleaned up, leading to a loss of usable storage space, even if the transfer completes normally.
 If you notice that the available storage space in a Node has decreased after a transfer during which aninterruption occurred, reboot the Node. The temporary files are deleted on reboot.
 Troubleshooting ConnectivityYou can use cURL to pinpoint connectivity problems among the components of your vCloud Connectorinstallation.
 Log on to the appropriate instance as admin either through the console or via SSH. The default password isvmware. The following procedure tests all the connections in order. Use whichever segments are useful to you.Use the -x, --proxy <[protocol://]proxyhost> option if necessary.
 VMware, Inc. 61

Page 62
                        

Prerequisites
 You have installed your vCloud Connector Server and Nodes and they are running. You have any necessaryproxy information.
 Procedure
 1 Test the vCC Server connections by logging on to the vCC Server.
 2 Test the connection between the vCC Server and a vCloud Director cloud:
 curl -k -v https://vcd-host/api/versions
 3 Test the connection between the vCC Server and a vCenter Server:
 curl -k -v https://vc-host/mob
 4 Test the connection between the vCC Server and a vCC Node:
 curl -k -v https://node-host/agent/api/v2/org/org/version
 5 If you are surfacing the vCloud Connector UI at vcloud.vmware.com, test the connection between vCCServer and the website:
 curl -k -v https://vcloud.vmware.com/api/versions
 6 Test the vCC Node connections used in the copy path by first logging on to the vCC Node located in thevSphere internal cloud.
 7 Test the connection between the vCC Node and the vCenter Server:
 curl -k -v https://vc-host/mob
 8 Test the connection between the vCC Node and the ESX host:
 curl -k -v https://esx-host/mob
 9 Test the connection between the vSphere vCC Node and a vCloud Director vCC Node outside the firewall:
 curl -k -v https://node-host/agent/api/v2/org/org/version
 10 Log on to the vCloud Director vCC Node.
 11 Test the connection between the vCloud Director vCC Node and the vCloud Director cloud:
 curl -k -v https://vcd-host/api/versions
 Accessing Log Files from the UIYou can access log files for a vCloud Connector Server or vCloud Connector Node instance from its AdminWeb console.
 NOTE If you are using a public cloud, you can only access your own log files, not those of other organizationsin the cloud.
 Procedure
 1 Go to the vCloud Connector Server or vCloud Connector Node Admin Web console athttps://<Server_or_Node_IP_address>:5480.
 2 Log on as admin.
 The default password is vmware.
 3 To download vCloud Connector Server log files, click the Server tab, then click the General tab and clickDownload logs.
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4 To download vCloud Connector Node log files, click the Node tab, then click the General tab and clickDownload logs.
 If you are using a vCloud Connector Node that has been deployed by a public vCloud Service Provideror private vCloud Director system administrator, you do not have access to the Node Admin Web console.Download the log files for your organization from the Server - Nodes tab of the Server Admin Web console.Click on the gears icon next to the Node and select Download Logs.
 Accessing Log Files from the ConsoleYou can access log files for a vCloud Connector Server or vCloud Connector Node instance through its console.
 Server log files are in the hcserver directory. Node log files are in the hcagent directory. Node log files aredivided by organization.
 NOTE If you are using a public cloud, you can only access your own log files, not those of other organizationsin the cloud.
 Procedure
 1 In your vSphere Client or vCloud Director cloud, open the instance console and log on as admin.
 The default password is vmware.
 2 Navigate to /opt/vmware/hcserver/logs or /opt/vmware/hcagent/logs/.
 3 View the hcs.log file (for vCloud Connector Server) or hca.log file (for vCloud Connector Node).
 Older log files are in a zip file in the same directory.
 For vCloud Connector Node, organization-specific log files arein /opt/vmware/hcagent/logs/<Organization>/.
 Tomcat log files are in catalina.<Date>.log.
 Troubleshooting Log File SizeTo modify the size of log files or the number of files that are retained, you must modify the vCloud ConnectorServer or Node configuration files.
 Prerequisites
 The original configuration file is backed up.
 Procedure
 1 Open the running instance console and log on as admin.
 The default password is vmware.
 2 For vCloud Connector Server, navigate to /usr/local/tcserver/springsource-tc-server-standard/server/webapps/hcserver/WEB-INF/classes/logback.xml.
 3 For vCloud Connector Node, navigate to /usr/local/tcserver/springsource-tc-server-standard/agent/webapps/agent/WEB-INF/classes/logback.xml
 4 Adjust the appropriate values in the following XML snippets:
 <rollingPolicy class="ch.qos.logback.core.rolling.FixedWindowRollingPolicy">
 <fileNamePattern>/opt/vmware/hcserver or hcagent/logs/hcs.%i.log.zip or hca.
 %i.log.zip</fileNamePattern>
 <minIndex>1</minIndex>
 <maxIndex>9</maxIndex>
 Chapter 9 Troubleshooting vCloud Connector
 VMware, Inc. 63

Page 64
                        

</rollingPolicy>
 <triggeringPolicy class="ch.qos.logback.core.rolling.SizeBasedTriggeringPolicy">
 <maxFileSize>10MB</maxFileSize>
 </triggeringPolicy>
 To modify the number of files to retain, change rollingPolicy/maxIndex to the desired number.
 To modify the size of log files, change triggeringPolicy/maxFileSize to the desired size.
 NOTE This is the size of a single file, so the total log size could be as large as this value times the maxNumbervalue. Archived log files are zipped, however, so the total log size is usually much smaller.
 5 Save the file. You do not need to restart.
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